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更にコード用例をお求めでしょうか？以下の通り対応いたします。 

常に成長する数百もの PSoC のコード用例のリストにアクセスするには、コード用例のウェブページを 
ご覧ください。PSoC のビデオ ライブラリについてはここからご覧ください。 

AN211293 は、PSoC®
アナログ コプロセッサについて紹介し、最初の設計を案内いたします。PSoC アナログ コプロッセサ

は、アナログ フロント エンド (AFE)、信号処理エンジンを有する ADC および DAC、およびホスト プロセッサとの通信インター

フェースを統合するシングル チップ ソリューションです。本アプリケーション ノートは、学習を加速するための追加リソースの

概要を提供します。 

目次 
1 はじめに .................................................................... 2 
2 PSoC リソース ........................................................... 3 
3 PSoC Creator ........................................................... 3 

3.1 PSoC Creator ヘルプ ....................................... 4 
3.2 テクニカル サポート ........................................... 4 

4 コード用例 ................................................................. 5 
5 PSoC アナログ コプロセッサの機能セット .................... 6 

5.1 PSoC Creator コンポーネントのコンセプト .......... 7 
6 最初の PSoC アナログ コプロセッサの設計 ................ 8 

6.1 始める前に準備するもの ................................... 8 
6.2 設計について .................................................... 8 
6.3 パート 1: 設計の作成 ......................................... 9 

6.4 パート 2: デバイスのプログラム ........................ 22 
6.5 パート 3: 設計のテスト ..................................... 24 

7 まとめ ...................................................................... 24 
8 関連アプリケーションノートとコード用例 ..................... 25 
改訂履歴 .......................................................................... 27 
ワールドワイド販売と設計サポート .................................... 28 
製品 ................................................................................. 28 
PSoC®

ソリューション ........................................................ 28 
サイプレス開発者コミュニティ ............................................ 28 
テクニカル サポート .......................................................... 28 
 

http://www.cypress.com/
http://www.cypress.com/CE211283
http://www.cypress.com/AN211294
http://www.cypress.com/documentation/code-examples/psoc-345-code-examples
http://www.cypress.com/video-library/PSoC


 
 

PSoC®アナログ コプロセッサ入門 
 

 www.cypress.com 文書番号: 002-12471 Rev. ** 2 

1 はじめに 
PSoC アナログ コプロセッサは、プログラム可能なアナログ フロント エンド (AFE) を統合するスケーラブルかつ再構成可能な 
アーキテクチャを提供することによって、センサーベース システムの設計を簡素化します。信号処理エンジン (32 ビット ARM® 

Cortex®-M0+）は、ソフトウェアで AFE を校正し、調整することができます。 

さらに、PSoC アナログ コプロセッサは、集められた処理前のフォーマット化されたセンサー データを、シリアル通信インター

フェースを介してホストプロセッサに送信する設計を可能にします。 

アナログ センサーは一般的に、出力電気信号に応じて、電圧、電流、抵抗、静電容量またはインダクタンスの 5 種類があります。

それぞれのセンサー種類は特定の AFE 設計を必要とします。例えば: 

 熱電対 (電圧出力の温度センサー) は計測用アンプを必要とします。 

 環境光センサー (電流出力センサー) はトランスインピーダンス アンプ (TIA) を必要とします。 

複数のアナログ センサーを使用するシステムは、一般的に AFE を実装するため複数の特殊 IC を必要とし、BOM コストと

PCB サイズを増加させます。IoT アプリケーション用に設計されるシステムは、複数のセンサーからのデータを結合して新たな

センス機能を可能にします。これは、センサー フュージョンとして知られています。センサー フュージョンのソリューションは、 
しばしばカスタム AFE を必要とします。PSoC アナログ コプロセッサは、特殊 IC の必要性を低減し、シングルチップ ソリュー

ションでカスタム AFE を作成する機能を提供します。 

図 1 はセンサー ベース システムの一般的なブロック図を示します。それは以下のものを含んでいます: 

1. 信号を増幅しフィルターすることによって、センサー出力を調整するためのアナログ フロント エンド (AFE) 

2. 調整されたセンサー出力をデジタル データに変換するためのアナログ-デジタル変換器 (ADC) またはコンパレータ (表
示なし) 

3. センサー データをフォーマット化しホスト プロセッサに送信するための、シリアル通信インターフェースを有するプログラマブル

信号処理エンジン 

図 1. センサーベース システム 
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このアプリケーション ノートは PSoC アナログ コプロセッサの機能を紹介し、シンプルな設計をスタートさせます。設計はサイ

プレスの CY8CKIT-048 キットのための、CE211283 コード用例として入手可能です。 

関連アプリケーションノートとコード用例セクションは、迅速に理解できるように様々な資料を提供しています。これは

AN211294, AFE Implementation Using PSoC Analog Coprocessor などの上級のアプリケーション ノートも含んでいます。 

http://www.cypress.com/
http://www.cypress.com/products/32-bit-arm-cortex-m0-psoc-4200-programmable-digital
http://www.cypress.com/AN211294
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2 PSoCリソース 
サイプレスは、www.cypress.com に大量の情報データを掲載しており、ユーザーがデザインに対して適切な PSoC デバイス
を選択し、迅速かつ効率的にデバイスをデザインに統合する手助けをしています。リソースの総合リストについては、 
「 KBA86521, How to Design with PSoC 3, PSoC 4, PSoC 5LP and PSoC Analog Coprocessor」を参照ください。以下
は簡略なリストです: 

 概要: PSoC Portfolio、PSoC Roadmap 

 製品セレクター: PSoC 1、PSoC 3、PSoC 4、
PSoC 5LPまたは PSoC Analog Coprocessor。
また、PSoC Creator にはデバイス選択ツール

が含まれています。 

 データシートは PSoC 3、PSoC 4、PSoC 5LP
および PSoC アナログ コプロセッサ デバイス 
ファミリの電気的仕様を説明し、提供します。 

 CapSense®
デザイン ガイド:PSoC 3、PSoC 4、

PSoC 5LP および PSoC Analog Coprocessor
デバイス ファミリを使用して、静電容量タッチ  
センス アプリケーションを設計する方法について

説明します。 

 アプリケーション ノートおよびコード用例は、基本的な 
レベルから上級レベルまで、幅広いトピックを提供します。

多くのアプリケーション ノートはコード用例を含んでいます。 

 テクニカル リファレンス マニュアル (TRM) は、PSoC 3、
PSoC 4、PSoC 5LP および PSoC アナログ コプロセッサ 
デバイス ファミリのそれぞれにおける、アーキテクチャ 
およびレジスタの詳細な説明を提供します。 

 開発キット: CY8CKIT-048 PSoC アナログ コプロセッサ

Pioneer Kit は安価で使い易い開発プラットフォームです。

このキットはスタンドアロン キットとしてまたは Arduino 
シールドとして機能します。 

3 PSoC Creator 
PSoC Creator は Windows ベースの統合開発環境 (IDE) です。無料で利用できます。これにより、PSoC 3、PSoC 4、
PSoC 5LP および PSoC アナログ コプロセッサに基づく、システムのハードウェアとファームウェアの同時設計が可能です。
図 2 に示すように、PSoC Creator により、以下のことが可能です: 

1. コンポーネントをドラッグ アンド ドロップして、 
メイン デザイン ワークスペースでハードウェア 
システム デザインを構築 

2. PSoC ハードウェアとアプリケーション ファーム

ウェアを同時設計 

3. コンフィギュレーション ツールを用いて、コンポーネントを構成 

4. 100 以上のコンポーネントを含むライブラリを利用 

5. コンポーネント データシートをレビュー 

図 2. PSoC Creator の特長 

 

http://www.cypress.com/
http://www.cypress.com/
http://www.cypress.com/knowledge-base-article/how-design-psoc-3-psoc-4-and-psoc-5lp-kba86521
http://www.cypress.com/psoc
http://www.cypress.com/product-roadmaps/cypress-psoc-and-mcu-portfolio-roadmap
http://www.cypress.com/products/psoc-1
http://www.cypress.com/search/psg/1292
http://www.cypress.com/search/psg/1297
http://www.cypress.com/search/psg/1307
http://www.cypress.com/products/psoc-analog-coprocessor
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=resource_meta_type%3A575
http://www.cypress.com/documentation/application-notes/an75400-psoc-3-and-psoc-5lp-capsense-design-guide
http://www.cypress.com/documentation/application-notes/an85951-psoc-4-capsense-design-guide
http://www.cypress.com/documentation/application-notes/an75400-psoc-3-and-psoc-5lp-capsense-design-guide
http://www.cypress.com/documentation/application-notes/an85951-psoc-4-capsense-design-guide
http://www.cypress.com/documentation/application-notes/an85951-psoc-4-capsense-design-guide
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=resource_meta_type%3A574
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A579
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=resource_meta_type%3A583
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A577
http://www.cypress.com/products/32-bit-arm-cortex-m0-psoc-4200-programmable-digital
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
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3.1 PSoC Creatorヘルプ 
PSoC Creator ホームページへアクセスし、PSoC Creator の最新版をダウンロードしてください。次に、PSoC Creator を起

動して以下のアイテムへナビゲートします: 

 クイック スタート ガイド: Help > Documentation > Quick Start Guide を選択します。このガイドは PSoC Creator 
プロジェクトを開発するための基礎知識を提供します。 

 システム リファレンス ガイド:Help > System Reference > System Reference Guide を選択します。このガイドは、

PSoC Creator が提供するシステム機能を記載し説明します。 

 コンポーネント データシート: コンポーネントを右クリックして「Open Datasheet」を選択します。すべての PSoC アナログ  
コプロセッサのコンポーネント データシートの一覧については、PSoC Analog Coprocessor Component Datasheets 
ページへアクセスしてください。 

 ドキュメント マネージャー: PSoC Creator は、ドキュメント リソースを容易に見つけレビューするのを助けるために、

Document manager を提供します。Document Manager を開くには、メニューから Help > Document Manager を選択

します。 

3.2 テクニカル サポート 
ご質問には弊社のテクニカル サポート チームが対応させて頂きますので、お気軽にご連絡ください。Cypress Technical 
Support ページにアクセスし、サポート リクエストを作成してください。 

米国のお客様は、テクニカル サポート チームに連絡する際、以下の電話番号 (通話無料) にお問い合わせください: +1-800-
541-4736 プロンプトでオプション「8」を選択してください。 

早急な対応が求められる場合には、下記の方法をご利用ください。 

 セルフ ヘルプ 

 各地の販売代理店 

http://www.cypress.com/
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
http://www.cypress.com/?id=4749&rtID=377
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A532
https://secure.cypress.com/myaccount/?id=25&techSupport=1&source=an79953
https://secure.cypress.com/myaccount/?id=25&techSupport=1&source=an79953
http://www.cypress.com/support
http://www.cypress.com/?id=1062
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4 コード用例 
PSoC Creator は多数のコード用例プロジェクトを提供しています。 
これらのプロジェクトは、図 3 に示すように、PSoC Creator のスタート 
ページからアクセスできます。 

用例のプロジェクトにより、空のページではなく出来上がった設計を元
に始めるため、設計時間を短縮することができます。また、用例のプロ
ジェクトは PSoC Creator コンポーネントを様々なアプリケーションに
使用する方法も示します。図 4 に示すように、コード用例、データシート 
(「Documentation」タブ) およびサンプル コードを含んでいます。 

図 4 に示す「Find Example Project」ダイアログには、いくつかのオプ
ションがあります: 

 アーキテクチャまたはデバイス ファミリ (PSoC 3、PSoC 4、PSoC 
5LP または PSoC アナログ コプロセッサ) またはカテゴリやキー
ワードに基づいて用例をフィルターします。 

 Filter Options に基づいて提供された用例のリストから用例を選択
します。 

 選択のためにデータシートをレビューします (「Documentation」
タブ上で) 。 

 選択のためにプロジェクトのコード用例をレビューします。コード 
開発時間を短縮させるために、このウィンドウからコードをコピーし
プロジェクトに貼り付けることができます。 

 選択したものをベースに新規プロジェクト (また必要な場合は新規
ワークスペース) を作成します。出来上がった基本的な設計を 
元に始めることで設計時間を短縮します。その設計をユーザーの
アプリケーションに適用できます。 

図 3. PSoC Creator のコード用例 

 

図 4. サンプル コードを含むコード用例プロジェクト 

 

http://www.cypress.com/
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5 PSoC アナログ コプロセッサの機能セット 
図 5 に示すように、PSoC アナログ コプロセッサは、広範なアナログ機能セットおよびその他のリソースを持っています。 

図 5. PSoC アナログ コプロセッサのブロック図 
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以下は PSoCアナログ コプロセッサの主な機能の一覧です。詳細は、デバイス データシート、 テクニカル リファレンス マニュアル 
(TRM) および関連アプリケーションノートとコード用例を参照ください。 

動作範囲および低消費電力モード 
·  デバイスの動作電圧範囲: 1.71V～5.5V 
·  スリープ モード (CPU へのクロック供給を切断)。

12MHz で標準電流 3.1mA 
·  ディープスリープ モード (アナログが動作可能)。 

標準電流 2.5µA 

プログラマブル アナログ ブロック 
·  汎用アナログ ブロック (UAB) 

UAB は以下のいずれか 1 つに構成可能: 
o 500kHz のサンプリング速度を持つ 12 ビット バッ

ファ電圧 DAC (VDAC) 
o ローパス、ハイパス、バンドパスまたはノッチ フィル

ターなどの第 2 次バイクアッド フィルター 
o 7.8Ksps のサンプリング速度および±1 LSB の

DNL 1
を備える 12 ビット デルタ シグマ ADC 

o 100spsのサンプリング速度および±2 LSBのDNLを備

える 14ビット インクリメンタル デルタ シグマADC 1 

·  4 個のプログラマブル オペアンプ 

o 90dBのオープンループ ゲイン、レイル ツー レイル

動作 

o 標準のオペアンプ回路を形成するために、外部

コンポーネントと組み合わせて使用可能 

o 最大 32 のゲインがあるプログラム可能なゲイン 
アンプ (PGA) を形成するために、内部抵抗アレイ

を使用可能 

o 外部 I/O 駆動時に 6MHzでのゲイン帯域幅 (最大
10mA) 

o SAR ADC など内部ノード駆動時に 8MHz での

ゲイン帯域幅 

o ±1mV の入力オフセット電圧 

o ディープスリープ モードで 15µA の動作電流 

·  2 個の低消費電力コンパレータ (CMP) 

o デバイスを低消費電力モードから復帰 

                                            
1 機能対応コンポーネントであり、2016 年後半に提供する予定です。 

http://www.cypress.com/
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·  12 ビット SAR ADC 

o 最大 1Msps のサンプリング速度 

o 選択可能な分解能: 8、10 または 12 ビット 
o 16 入力チャネルを搭載する自動ハードウェア  

シーケンサー 

o 各チャネルは差動またはシングルエンドになる 

o チャネルごとに統合されたハードウェア平均化要素 
o 外部ピン、オペアンプおよび UAB などのプログラム

可能な入力チャネル 

·  シングル スロープ ADC 

o 選択可能な分解能: 8 または 10 ビット 

o サンプリング速度: 最大 11.6ksps (10ビット分解能) 
o 入力測定範囲: すべての GPIO ピンで VSS から

VDDAまで 
o CapSense ブロックに実装される 

·  プログラマブル リファレンス ブロック (PRB) 

o VDDAから VSSまで、または 1.2V から VSSまでの 16 
ステップで独立して調整可能な 4 個の電圧リファ
レンス 

o リファレンスは ADC、VDAC、コンパレータ、オペア
ンプの内部高インピーダンス アナログ リソースに
接続される 

o オペアンプを介してバッファリングされる場合、リファ
レンスは GPIO にも接続可能 

·  CapSense® 
o 静電容量を測定し、液体レベルやタッチ センス  

アプリケーションなどの静電容量センサーと一緒
に使用される 

o 自己容量および相互容量のセンス方式 
o スペクトラム拡散クロックおよびプログラマブル  

スルーレート制御を使用して電磁妨害 (EMI) を改善 

·  IDAC 
o CapSense との使用または汎用アプリケーション

用の 2 個の 7 ビット電流 DAC (IDAC) 

o 単一の 8 ビット IDAC は 2 個の IDAC を並行に

組み合わせることによって生成される 

o 正確な静電容量測定用の 37.5nA LSB 電流 

o ソースまたはシンク構成の 6 つの出力電流範囲 
(4.76µA～609µA) 

32 ビットの信号処理エンジン 

·  最大 48MHz で動作する ARM Cortex-M0+ CPU 

·  読み出し加速装置を備えた最大 32KB のフラッシュ 

·  最大 4KB の SRAM 

·  8 チャネルのダイレクト メモリ アクセス (DMA) コント

ローラー 

·  リアルタイム クロック (RTC) アプリケーション用の時

計水晶発振器 (WCO) 

·  SPI、I2C または UART に設定可能な 3 個のシリアル

通信ブロック (SCB) 

·  8 個の 16 ビット タイマー／カウンター／パルス幅変

調器 (TCPWM) ブロック 

I/O サブシステム 
·  アナログ、デジタル、CapSense またはセグメント

LCD 機能のために使用される最大 38 個の GPIO 

·  プログラマブルな駆動モードおよびスルー レート 

·  ピン信号で論理演算を実装できる 8 個のスマート I/O 

5.1 PSoC Creatorコンポーネントのコンセプト 
PSoC 設計が成功するための鍵は PSoC Creator IDE です。PSoC Creator では、PSoC ペリフェラルと他のリソースを「コン
ポーネント」と呼ばれる図式要素として要約します。コンポーネントは回路図にドラッグ & ドロップされ、互いに接続されるため、 
ハードウェア設計の段階を簡略かつ高速に実行できます。設計の変更は数回のマウス クリックだけで迅速に実現できます。 

以下のコンポーネントは、プログラマブルなアナログ ブロックを使用する設計のために提供されます: 

 プログラマブル ゲイン アンプ (PGA) およびオペアンプ 

 UAB に実装される電圧 DAC (VDAC) 

 SAR ADC で実装される SAR ADC のスキャン 

 PRB に実装されるプログラマブル Vref (PVref) 

 シングル スロープ ADC で実装される CapSense ADC 

各コンポーネントはデータシートを持っています。コンポーネントの詳細については、そのデータシートを参照ください。すべて
の PSoC アナログ コプロセッサのコンポーネント データシートの一覧については、PSoC Analog Coprocessor Component 
Datasheets ページへアクセスしてください。 

http://www.cypress.com/
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A532
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A532
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6 最初のPSoCアナログ コプロセッサの設計 
このセクションは、簡単なセンサー ベース AFE の設計をビルドし、その設計を開発キットにプログラムするのに役立ちます。
PSoC Creator IDE を使用する PSoC 設計技術の学習を容易にする詳細な手順を提示します。 

6.1 始める前に準備するもの 
6 .1 .1 PSoC Creatorをインストールしましたか？  

PSoC Creator ホームページから PSoC Creator をダウンロードし、インストールします。PSoC Creator 3.3 SP2 以降で
PSoC アナログ コプロセッサ ファミリをサポートします。 

6.1.2 開発キットを持っていますか？  
この設計は CY8CKIT-048 PSoC アナログ コプロセッサ Pioneer Kit のために開発されます。このキットは、Arduino™シールド

およびベースボードとのフットプリント互換性をサポートしています。これは、1 個の RGB LED、2 個のプッシュ ボタン スイッチ、

1 個のサイプレス F-RAM™および基板搭載プログラマ／デバッガーおよび USB-UART/I2C ブリッジの 1 個の KitProg2 という

5 個の基板搭載センサーを搭載しています。 

6.1.3 実行中のプロジェクトをご覧になりたいですか？  
設計過程を追いたくない場合は、http://www.cypress.com/CE211283 において、完成したコード用例プロジェクトを取得でき

ます。そして、ビルドおよびプログラムのステップへ進むことができます。 

6.2 設計について 
この設計は、環境光センサー用のシンプルなアナログ調整回路を実装します。環境光センサーからの出力は、環境光の照度

に比例した弱い電流信号です。図 6 は、この電流信号を調整し測定するための PSoC Creator 回路図を示します。  

図 6. 最初の PSoC アナログ コプロセッサの設計 

 

環境光センサーからの電流出力は、1 個のオペアンプと外部受動素子からなるトランスインピーダンス アンプ (TIA) を介して、

電圧信号に変換されます。TIA のリファレンス電圧は PRB ブロックで 1.20V に設定されます。TIA の出力は、12 ビット SAR 
ADC を使用して測定され、環境光の 0～1Klux の照度範囲の割合に応じて校正されます。この比率は、PWM のデューティ

比として用いられます。PWM の出力に接続された LED は、環境光の照度に比例する明るさの変化を示します。 
注: CY8CKIT-048 PSoC アナログ コプロセッサ Pioneer Kit は、必要な環境光センサーを基板上に搭載し、PSoC アナログ 
コプロセッサに接続されています。追加コンポーネントは、設計をテストするために必要とされません。 

http://www.cypress.com/
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
http://www.cypress.com/CY8CKIT-048
http://www.cypress.com/CE211283
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6.3 パート 1: 設計の作成 
このセクションは設計過程を順を追って説明します。ハードウェアとファームウェアの両方の設計エントリについて解説します。 

注: これらの手順では、ユーザーが PSoC Creator 3.3 SP2 以降を利用していることを前提にします。全体的な開発過程は、

PSoC Creator の以降のバージョンでも同様ですが、いくつかのダイアログ ボックスに変更があることがあります。 

1. 新しい PSoC Creator プロジェクトを作成します。 

a. PSoC Creator を起動します。 

b. 図 7 に示すように、メニューから File > New > Project を選択します。 

「Create Project」ウィンドウが開きます。 

図 7. 新しい PSoC Creator プロジェクトの作成 

 

2. 図 8 に示すように、PSoC Analog Coprocessor をターゲット デバイスとして選択します。 

PSoC Creator は、自動的に様々なプロジェクト オプションを特定の開発キットやターゲット デバイスに設定できるため、

開発時間を短縮できます。  

A. Target device をクリックします。 

B. プルダウン メニューでは、PSoC Analog Coprocessor を選択します。  

C. Next をクリックします。 

PSoC Creator は、PSoC アナログ コプロセッサ ファミリのデフォルト デバイスとして CY8C4A45LQI-483 を選択します。

このデバイスは、CY8CKIT-048 PSoC アナログ コプロセッサ Pioneer Kit に装着されます。 

図 8. ターゲット デバイスの選択 

 

A 

B 

C 

http://www.cypress.com/
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3. 図 9 に示すように、「Empty Schematic」を選択します。  

A. Empty Schematic をクリックします。 

B. Next をクリックします。 

C. 図 10 に示すように、次のダイアログの Workspace name にワークスペースの名前を入力します。1 つのワークス

ペース名にいくつかのプロジェクトを格納できます。 

D. ワークスペースの Location を指定します。 

E. Project nameにプロジェクトの名前を入力します。プロジェクト名とワークスペース名は同じでも違っても構いません。 

F. Finish をクリックします。 

図 9. 回路図テンプレートの選択 

  

図 10. プロジェクトの命名および保存先 
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B 

C 

D 
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http://www.cypress.com/


 
 

PSoC®アナログ コプロセッサ入門 
 

 www.cypress.com 文書番号: 002-12471 Rev. ** 11 

4. 図 11 に示すように、プロジェクトの回路図がデフォルトで開きます。ここでは、ハードウェア設計回路図が作成されます。

「Workspace Explorer」ウィンドウでの関連ファイル TopDesign.cysch に注目します。回路図が表示されない場合は、

このファイルをダブルクリックして回路図を開きます。 

図 11. 回路図 

 

5. ステップ 3 で「Empty Schematic」を選択したため、「Top Design」は空白になります。図 11 に示すように、コンポーネント  
カタログはウィンドウの右側にあります。コンポーネント カタログが表示されなかったら、View > Component Catalog
のメニュを選択してそれを開きます。ユーザーはここで、コンポーネントの配置を開始できます。  

6. 回路図にトランス インピーダンス アンプ (TIA) を作成することから始めます。図 12 に示すように、コンポーネント カタログ

からオペアンプ コンポーネントを選択し、配置します (ドラッグ & ドロップ)。「Analog」グループの「Amplifiers」サブグループ

内のオペアンプ コンポーネントを見出します。 

図 12. オペアンプ コンポーネントの選択 

 

デフォルトでは、コンポーネントのインスタンス名は Opamp_1 になります。コンポーネントは、中電力設定などのデフォルト 
プロパティで設定されています。次のステップでは、このアプリケーションの設定を変更します。 

http://www.cypress.com/
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7. 「Opamp Component」をダブルクリックして、それを設定します。図 13 に示す通り、コンポーネントを設定します。 

A. コンポーネントを「Opamp_TIA」として命名します。 

B. OpAmp モードが (デフォルト設定として) 選択されることを確認してください。 

C. オペアンプ出力をピンに接続するために、Output to pin オプションを有効にします。 
図 13 に示すように、各コンポーネントは、設定ウィンドウからアクセスできる関連のデータシートを持っています。コンポーネ
ント データシートは、コンポーネントの設定、アプリケーション プログラミング インターフェース (API) および電気的仕様
の詳細情報を提供します。 
残りの設定はそれぞれ初期値のままにしておきます。各設定の重要性を理解できるように、コンポーネント データシート
を参照ください。 

OK クリックして設定を保存し、ウィンドウを閉じます。 

図 13. オペアンプ コンポーネントの設定 

 

8. 同様に、図 14 に示すように、PVref のコンポーネント (「Component Catalog」の「Analog」グループにある) を配置し、 
そのパラメータを設定します。このコンポーネントは、TIA のリファレンスおよび SAR ADC の反転入力を 1.20V に設定し
ます。 

A. コンポーネントを「PVref」と命名します。 

B. 「Reference source」を Bandgap (V) 1.20 に設定します (デフォルト)。 

C. 「Voltage reference」 (V) を 1.20 (tap 16) に設定します (デフォルト)。 

図 14. プログラマブルなリファレンスの設定 
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9. 図 15 に示すように、オペアンプ コンポーネント (「Component Catalog」の「Analog」グループの「Amplifiers」サブグループ

にある) を配置し、そのパラメータを設定します。このコンポーネントは、PVref のコンポーネントによって生成されたリファ

レンス電圧をバッファリングするために使用されます。 

A. コンポーネントを「Opamp_Buffer」として命名します。 

B. 「Mode」を Follower に設定します。 

図 15. Opamp_Buffer の設定 

 

A 

B 
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10. 図 16 に示すように、スキャン SAR ADC (「Component Catalog」の「Analog」グループの ADC サブグループにある) を
配置し、そのパラメータを設定します。 

A. コンポーネントを「ADC」と命名します。 

B. 「Free-run scan rate (SPS)」を 1000 に設定します。 

C. 「Vref select」を System bandgap voltage (1.200 V)に設定します。測定範囲は SAR ADC の反転入力での電

圧に対して±1.2V の相対的な値です。 

D. TIA 出力のみが測定される必要があるため、「Number of channels」を 1 に設定します。 

E. 「Input mode」を Differential に設定します (デフォルト)。 

図 16. SAR ADC の設定 - 設定タブ 
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11. Component Catalog の「Digital」グループの「Functions」サブグループにある PWM コンポーネントを配置します。この

コンポーネントは、LED を駆動するために使用されます。図 17 に示す通り、コンポーネントを設定します。 

A. コンポーネントを「PWM」と命名します。 

B. 「Period value」を 100 に設定します。これは、PWM 出力デューティ比がパーセント (0～100%) で直接制御される

ことを可能にします。 

C. デューティ比 90%の初期出力のために「Compare」の値を 90 に設定します。この値は実行時にファームウェアで変

更されます。 

PWM 出力周波数は、次のステップで設定されるクロック入力に依存します。 

図 17. PWMコンポーネントの設定 

 

A 

B 
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12. 「Component Catalog」の「System」グループにあるクロック コンポーネントを配置します。このコンポーネントは、PWM
コンポーネントへのクロックを駆動するために使用されます。図 18 に示すように、コンポーネントを「Clock」と命名し、 
デフォルト周波数を 12MHz に設定します。上記のステップで PWM 周期を 100 に設定した場合、PWM の出力周波数は

120kHz になります。 

図 18. クロック コンポーネントの設定 

 

13. ピンの配置および設定: 

まず、TIA 入力にピンを配置し、設定します。TIA 入力がアナログ入力であるため、Component Catalog 内の「Ports 
and Pins」グループにあるアナログ ピン コンポーネントを選択します。 

A. コンポーネントを「Pin_Sensor」と命名します。 

B. External terminal を有効にします。これにより、外部 (オフチップ) のコンポーネントを配置し、接続することができ

ます。回路図での外部コンポーネントは明確にするために含まれています。 設計に影響を与えません。 

図 19 は Pin_Sensor の設定を示します。 

図 19. Pin_Sensor コンポーネントの設定 

 

次は、Pin_Sensor と同様に、TIA 出力に他のアナログ  ピン  コンポーネントを配置します。コンポーネントを

「Pin_TIAOutput」と命名し、External terminal を有効にします。 

A 

B 
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LED を駆動するために、デジタル出力ピンを配置します。図 20 を示すように、ピンを「Pin_LED」と命名し、External 
terminal を有効にします。残りの設定はそれぞれ初期値のままにしておきます。 

図 20. Pin_LED の設定 

 

14. 前のステップで説明したように、オフチップ コンポーネントは回路図でオプションです。図 21 に示すように、これらのコン

ポーネントは「Component Catalog」の「Off-Chip」タブにあります。オフチップ コンポーネントを含みたいのであれば、該

当するコンポーネントを配置してそれらの値を表 1 に示すように設定します。 

図 21. オフチップ コンポーネント 

 

表 1. ピンおよび外部コンポーネントのコンフィギュレーション 

コンポーネント 

コンポーネント カタログ  

タブ グループ 値 

フォトダイオード Off-Chip Diodes - 

抵抗 Off-Chip Passive 220K 

コンデンサ Off-Chip Passive 0.1µF 

抵抗 Off-Chip Passive 2.2K 

LED Off-Chip Diodes - 

Vdd Off-Chip Power - 

グランド Off-Chip Power - 
 

 
これで、コンポーネントの配置と設定が完了します。次のステップでは各コンポーネントを繋げます。 

15. ワイヤー ツールを選択します (図 22を参照ください) 
 (または簡単な方法として「w」を押しても可能)。 

図 6 に示すように、コンポーネントの端子を一緒に

配線します。 

図 22．ワイヤー ツール 
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16. これで、ハードウェアの設計が完成しましたが、ピン コンポーネントを物理ピンに接続させなければなりません。使用して

いる開発キットの物理的なピンを選択します。 

A. Workspace Explore window (ワークスペース エクスプローラウィンドウ) では、My_First_Design.cydwr ファイルを

ダブルクリックします。 

B. Pins タブを選択します。デザインに使用されるピンはリストに表示されます。 

C. 図 23 に示すように、デザインに使用される各ピン コンポーネントの所望の物理的ピンを選択します。 

図 23. ピン配置 

 

CY8CKIT-048 PSoC アナログ コプロセッサ Pioneer Kit を使用している場合、ピンは表 2 の通り設定される必要があり

ます: 

表 2. CY8CKIT-048 の場合の物理ピンの割り当て 

ピン コンポーネント名 物理ピン 

Pin_Sensor P2[4] 

Pin_TIAOutput P2[3] 

Pin_LED P1[4] 

 

A 

B 

C 
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17. 今、ハードウェア構成の設定が終了し、ファームウェア コードを追加する時です。しかし、そうする前に、PSoC Creator に
コンポーネントと関連する API コードを生成させることが最善です。図 24 に示すように、Build> Generate Application
を選択します。図 25 に示すように、エラーがなければ、PSoC Creator は Generated_Source フォルダにいくつかの 
コード ファイルを生成します。 

図 24. アプリケーションの生成 

 

図 25 に示すように、ワークスペースから自動生成したファイル main.c を開きます。 

図 25. 生成されたソース ファイル 
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コード 1 のコードをユーザーのプロジェクトの main.c ファイルに追加します。コードは以下のタスクを実行します: 

 Opamp_TIA_Start()などのコンポーネント API 関数を使用してコンポーネントを初期化します。 

 ADC 変換の結果を読み出し、フィルターします。 

 フィルターされた ADC 変換結果をパーセントの値に変換します。 

 計算されたパーセントで PWMデューティ比を更新します。 

コード 1. main.c 

#include <project.h> 
#include "stdio.h" 
 
/* IIR Filter Coefficient */ 
#define FILTER_COEFFICIENT_ALS 8 
 
/* ADC Channel for ALS - Channel 0 */ 
#define ALS_CHANNEL 0x00 
 
/* ADC Counts at 1K lux illuminance, calculated based on the sensor TEMD6200FX01 datasheet */ 
#define ADCCOUNTS_1K_LUX 0x96 
 
int main() 
{ 
    /* Variables */ 
    int ADCResult, ADCFiltOut=0, ALSPercent; 
 
    /* Enable global interrupt */ 
    CyGlobalIntEnable;  
 
    /* Start the TIA */ 
    Opamp_TIA_Start(); 
 
    /* Start the Reference Voltage */ 
    PVref_Start(); 
 
    /* Start the Opamp buffer */ 
    Opamp_Buffer_Start(); 
 
    /* Start the SAR ADC; continuous conversions */ 
    ADC_Start(); 
    ADC_StartConvert(); 
 
    /* Start the PWM */ 
    PWM_Start(); 
 
    for(;;) 
    { 
        /* ADC scan rate is set to 1ksps */  
        /* Check if the ADC result is ready */         
        if(ADC_IsEndConversion(ADC_RETURN_STATUS)) 
        { 
        /* Get the sign extended 16 bit result with 11 bits of magnitude */ 
        ADCResult = ADC_GetResult16(ALS_CHANNEL); 
             
        /* IIR Filter - sample rate: 1 ksps */ 
        /* Weight on the new sample is 1/8, and weight on the previous filter output is 7/8 */ 
        ADCFiltOut = (ADCResult + (FILTER_COEFFICIENT_ALS - 1) * ADCFiltOut) / 
                     FILTER_COEFFICIENT_ALS; 
 
        /* Convert filtered data into percentage. Filter output is multiplied by -1, so that 
           the percentage value is directly proportional to the ambient light illuminance */ 
        ALSPercent = (-1*ADCFiltOut*100) / ADCCOUNTS_1K_LUX; 
 
        /* Limit the values between 0 to 100 to express the ambient light  
        illuminance in percentage for a given operating window (0 to 1 Klux)*/ 
        ALSPercent = (ALSPercent > 100) ? 100 : ((ALSPercent < 0) ? 0 : ALSPercent); 
 
        /* Update PWM duty cycle. The LED has an active low connection on the CY8CKIT-048 kit. */ 
        PWM_WriteCompare(PWM_PWM_PERIOD_VALUE - ALSPercent); 
        } 
    } 
} 

http://www.cypress.com/
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18. 設計過程を飛ばしてこのステップに進んだ場合、以下のようにしてください: 

A. CE211283.zip のコード用例のファイルを http://www.cypress.com/CE211283 からダウンロードし、コンピューター

の便利な位置に展開します。 
B. 6.1.1 セクションで説明したように、PSoC Creator をダウンロードし、インストールします。 
C. CE211283.cywrk ファイルを開きます。 
D. プロジェクトのピンの割り当てがユーザーの開発キット (DVK) に一致するか否かを確認します。CY8CKIT-048 の場

合は表 2 を参照ください。 

E. 図 26 に示すように、 Build > Build <プロジェクト名>を選択します。エラーがなければ、プロジェクトはビルドされ、

ターゲットの DVK にプログラムできる状態になります。 

図 26. プロジェクトのビルド 

 

http://www.cypress.com/
http://www.cypress.com/CE211283
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6.4 パート 2: デバイスのプログラム 
1. DVK をユーザーのコンピューターの USB ポートに接続します。 

2. PSoC Creator とユーザーの DVK の接続を確認します。これを行うためには、図 27 に示すように、まず PSoC Creator
のメニューから「Debug > Select Debug Target」を選択します。  

図 27. デバッグ ターゲットの選択 

 

A. 図 28 に示すように、「Select Debug Target」ダイアログが表示されます。ターゲットの DVK をクリックします。  
(PSoC Creator は多くの DVK 接続をサポートします)  

B. Port Acquire をクリックします。 

図 28. ターゲットの設定 

 

A 

B 
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3. ターゲットの DVK 上の PSoC に接続します。図 29 を参照ください。 

A. PSoC Analog Coprocessor をクリックします。 

B. Connect をクリックします。「Target unacquired」メッセージが「Target acquired」になり、ボタンのラベルは

「Disconnect」に変わります。 

C. OK をクリックしてダイアログを閉じます。 

これで、PSoC Creatorはターゲットの DVK と PSoCに接続され、PSoCデバイスをプログラムすることが可能になります。 

図 29. PSoC アナログ コプロセッサに接続 

 

4. 図 30 に示すように、PoC アナログコプロセッサをプログラムするために、Debug > Program を選択します。 

図 30. PSoC プログラミング 

 

A 

B 

C 
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5. プログラミングが始まります。図 31 に示すように、プログラミング状況は PSoC Creator のステータス バー (画面の左下隅) 
に表示されます。 

注: 「This programmer is currently out of date」の警告メッセージが表示される場合があります。プログラマ ファームウェアを

アップグレードする方法については、キットの資料にある KitProg ユーザー ガイドを参照ください。 

図 31. プログラミングの状態 

                  

6.5 パート 3: 設計のテスト 
以下の各ステップを実行して設計をテストします: 

1. 図 32 に示すように、CY8CKIT-048 DVK の USB ポートを PC に接続します。 

図 32. CY8CKIT-048 DVK 

 

2. 環境光センサー (ALS) の上に手を移動し、それに応じて赤色 LED の輝度も変化することを観察してください。十分な環

境光がある場所へのテスト環境の移動が必要な場合があります。 

7 まとめ 
本アプリケーションノートは、PSoC アナログ コプロセッサ デバイスを紹介し、ユーザーの最初のデザインを作成するのに役

立ちます。また、本アプリケーション ノートは、迅速に理解できるように追加リソースの概要を説明しました。 

ALS 

LED 

http://www.cypress.com/
http://www.cypress.com/CY8CKIT-048
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8 関連アプリケーションノートとコード用例 
表 3 に、PSoC と PSoC Creator の学習の次段階に推奨される選択されたシステム レベルおよび一般的なアプリケーション

ノートを示します。 

表 3. 一般的なシステム レベルのアプリケーション ノート 

文書番号 文書名 

AN86233 PSoC 4 and PSoC Analog Coprocessor Low-Power Modes and Power Reduction Techniques 

AN88619 PSoC 4 Hardware Design Considerations 

AN73854 PSoC 3, PSoC 4, and PSoC 5LP Introduction to Bootloaders 

AN89056 PSoC 4 – IEC 60730 Class B and IEC 61508 SIL Safety Software Library 

 
表 4 はデバイスの特定ペリフェラルおよびアプリケーションのアプリケーション ノート (AN) およびコード用例 (CE) を示します。 

表 4. PSoC アナログ コプロッセサ機能に関連する資料 

文書番号 文書名 

プログラマブル アナログ 

AN211294 AFE Implementation Using PSoC Analog Coprocessor 

AN60590 PSoC 3, PSoC 4 and PSoC 5LP - Temperature Measurement with a Diode 

AN70698 PSoC 3, PSoC 4 and PSoC 5LP – Temperature Measurement with an RTD 

AN66477 PSoC 3, PSoC 4 and PSoC 5LP – Temperature Measurement with a Thermistor  

CE211252 Interfacing PSoC Analog Coprocessor with Ambient Light Sensor 

CE211301 Interfacing PSoC Analog Coprocessor with PIR Motion Sensor 

CE211305 Interfacing PSoC Analog Coprocessor withInductive Proximity Sensor 

CE211321 Interfacing PSoC Analog Coprocessor withThermistor 

CE211322 Interfacing PSoC Analog Coprocessor with Humidity Sensor  

CPU および割り込み 

AN89610 PSoC 4 and PSoC 5LP ARM Cortex Code Optimization 

AN90799 PSoC 4 Interrupts 

I/O 

AN86439 PSoC 4 and PSoC Analog Coprocessor - Using GPIO Pins 

CapSense 

AN85951 PSoC 4 and PSoC Analog Coprocessor CapSense® Design Guide 

AN92239 Proximity Sensing with CapSense 

ブートローダ 

AN86526 PSoC 4 and PSoC Analog Coprocessor I2C Bootloader 

AN68272 PSoC 3, PSoC 4, PSoC 5LP and PSoCAnalog Coprocessor UART Bootloader 

セグメント LCD 

AN87391 PSoC 4 Segment LCD Drive 

プログラミング 

AN84858 PSoC 4 Programming Using an External Microcontroller (HSSP) 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an86233-psoc-4-low-power-modes-and-power-reduction-techniques?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an88619-psoc-4-hardware-design-considerations?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an73854-psoc-3-psoc-4-and-psoc-5lp-introduction-bootloaders?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an89056-psoc-4-iec-60730-class-b-and-iec-61508-sil-safety-software?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an60590-psoc-3-psoc-4-and-psoc-5lp-temperature-measurement-diode
http://www.cypress.com/documentation/application-notes/an70698-psoc-3-psoc-4-and-psoc-5lp-temperature-measurement-rtd
http://www.cypress.com/documentation/application-notes/an66477-psoc-3-psoc-4-and-psoc-5lp-temperature-measurement
http://www.cypress.com/documentation/application-notes/an89610-psoc-4-and-psoc-5lp-arm-cortex-code-optimization
http://www.cypress.com/documentation/application-notes/an90799-psoc-4-interrupts?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an86439-psoc-4-using-gpio-pins?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an85951-psoc-4-capsense-design-guide?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an92239-proximity-sensing-capsense
http://www.cypress.com/documentation/application-notes/an86526-psoc-4-i2c-bootloader?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an68272-psoc-3-psoc-4-and-psoc-5lp-uart-bootloader?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an87391-psoc-4-segment-lcd-direct-drive?source=search&cat=technical_documents
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